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Conventions
The acronym SNT is used when refering to Super NoteTab and NTP when refering to NoteTab Pro. The 
name NoteTab is used to refer to either SNT or NTP. The Editor Clipbook tool is often refered to as just 
Clipbook.

The pipe symbol "|" is used to separate imbedded menu names or dialog box elements. For example:

"Modify | Change Case | Capitalize"
refers to the Capitalize command in the Change Case submenu situated under the Modify menu.

"Options | Clipbook | Indent on Paste"
referers to the Indent on Paste setting on the Clipbook tab in the Options dialog box.



Introduction
NoteTab is a top-rated text editor (Super NoteTab is a PC Magazine Shareware Awards finalist 1997) 
capable of handling any number of documents of virtually any size. It is user-friendly but feature-rich with 
innovative productivity tools.

The editor has a superb interface with a fully customizable toolbar and a tab bar to easily switch between 
documents. It has the original "Editor Clipbook" which lets you easily insert any kind of text into your 
documents (HTML tags, glossaries, ...). Another great feature is its support for Outline documents - 
organizing information has never been easier. NoteTab is web sensitive so it can open links in your text or
view documents in the default browser. Other features include search/replace text in all open documents 
or disk files, text filters (convert between ASCII, UNIX, MAC), change case, strip HTML tags or convert to 
HTML, sort/join/ split/indent lines, calculates mathematic al expressions, Favorites menu, detailed text 
statistics, automatic scrolling, capture text sent to the Clipboard, extensive support for drag-and-drop, 
shortcut menus, detailed help file, and much more...

Want to contribute to NoteTab's future? Why not contact the editors of your favorite computer 
magazine or newspaper, or web sites that review software, and tell them about it! UseNet is also a 
great place to tell others about NoteTab. The more it is mentioned, the more people will discover 
it, the more NoteTab will thrive and get better.



The NoteTab Family
The NoteTab family of editors is composed of three variants:

1. NoteTab Pro (Commercial)
· Works under Windows 95 and Windows NT4, or higher
· Can edit files up to 16 Mb each
· Very fast
· Multi-level undo/redo
· Supports fixed-pitch OEM fonts
· Bookmarks
· URL and HTML tag highlighting
· Spell checker and thesaurus
· Full support for NoteTab-Outline documents
· Search/replace text in files on disk
· Options for word wrap at column, tab types, etc.
· Available from:    http://www.ideamarket.com/
· Cost: only $9.95 USD!!! (Maintenance updates are free)

2. Super NoteTab (Commercial)
· Works under Windows 95 and Windows NT4, or higher
· Can edit files up to 2 Gb or as large as memory permits
· Spell checker and thesaurus
· Full support for NoteTab-Outline documents
· Search/replace text in files on disk
· Can search/replace text criteria with multiple lines
· Can drag-and-drop text
· Can display variable- and fixed-width fonts
· Cannot display fonts with OEM character sets (Terminal, MS Line Draw,...)
· Available from:    http://www.ideamarket.com/
· Cost: only $5 USD!!! (Maintenance updates are free)

3. Super NoteTab Light (Freeware)
· Same features as Super NoteTab except those listed below:
· No spell checker or thesaurus
· Can read NoteTab Outline documents but cannot create them
· Can search for text in disk files but cannot perform a replace operation



NoteTab Pro
NoteTab Pro is one of the commercial versions of the NoteTab series of editors. It uses a more 
sophisticated input control that provides many options to configure its behaviour (wrap to column, scroll 
past end of line, real/fixed/smart tabs, etc.). Furthermore, it offers multiple-level undo/redo, bookmarks, 
URL and HTML-tag highlighting, a spell checker and a thesaurus. Note that, unlike Super NoteTab, 
NoteTab Pro only supports fixed-width font.

NoteTab Pro costs only $9.95 USD!!! The program is available for sale at ideaMarket™ and can be 
downloaded from their web site at...

http://www.ideamarket.com/

ideaMarket™ has exclusive rights for distribution, so you cannot purchase a registered copy from the 
author. ideaMarket™ currently accepts checks and Visa, MasterCard, and American Express credit cards.
If you are using the Freeware version of Super NoteTab or the trial version of NoteTab Pro, you can easily
order the software by choosing the "Ordering Information" command in the Help menu.

The main advantages of NoteTab Pro over Super NoteTab are:

· Speed
· URL and HTML-tag highlighting
· Multiple-level undo/redo
· Bookmarks
· Wrap to column
· Choice between real/fixed/smart tabs

See the comparison chart for the differences between NoteTab Pro and Super NoteTab.



Super NoteTab
Super NoteTab is similar to Super NoteTab Light (the Freeware version) but adds a spell checker, 
thesaurus, full support for NoteTab-Outline documents, and a fully enabled command for search/replace 
text criteria in disk files.

Super NoteTab costs only $5 USD!!! The program is available for sale at ideaMarket™ and can be 
downloaded from their web site at...

http://www.ideamarket.com/

ideaMarket™ has exclusive rights for distribution, so you cannot purchase a registered copy from the 
author. ideaMarket™ currently accepts checks and Visa, MasterCard, and American Express credit cards.
If you are using the Freeware version of Super NoteTab or the trial version of NoteTab Pro, you can easily
order the software by choosing the "Ordering Information" command in the Help menu.

The main advantages of Super NoteTab over NoteTab Pro are:

· Text selection drag-and-drop
· Can use fixed- and variable-width fonts
· Works better with non-roman alphabets

See the comparison chart for the differences between NoteTab Pro and Super NoteTab.



Comparison Chart
NoteTab Pro and Super NoteTab features compared:

NoteTab Pro Super NoteTab

Maximum file size 16 Mb 2 Gb
Speed Very fast Relatively slow with 

large files
Multi-level undo/redo Yes No
Use OEM fonts Yes No
Use variable-width fonts No Yes
URL and HTML highlighting Yes No
Spell checker Yes Not with Freeware 

version
Thesaurus Yes Not with Freeware 

version
Bookmarks Yes No
Text drag-and-drop No Yes
Multiple tabulator settings No Yes
Can wrap text to column Yes Not in real time
Cost $9.95 USD Free or $5 USD for 

commercial version



Key Features
· Covers all essential features available in Notepad (including LOG).
· Open and edit many documents at once (only limited by system resources).
· Use files up to 16 Mb (NoteTab Pro) or 2 Gb (Super NoteTab) in size.
· NoteTab Pro: multi-level undo/redo.
· Fully configurable toolbar with flat or standard style buttons (more than 80 commands available).
· Fully configurable shortcut menu.
· Web enabled: can open links and HTML documents in browser.
· Powerful Clipbook tool makes it easy to memorize and insert any kind of text in your document. 

Includes libraries for HTML tags, acronyms, smilies, etc. Can also be used for "shorthand" glossaries 
or to launch other applications.

· Innovative In-Context Clipbook reduces mouse movement and speeds up work.
· Can calculate (type a mathematical expression and NoteTab will calculate the result).
· Each document can have different settings such as font, tab widths, word wrap.
· Supports outline-type documents that help you organize your notes or any kind of information.
· Supports document templates.
· Can search/replace text in all open documents or disk files; accepts search tokens.
· Functions to convert text files to web documents, strip HTML tags, sort lines, change case, process 

text in blocks, etc.
· NoteTab Pro: can highlight URLs and HTML tags.
· NoteTab Pro and Super NoteTab: spell checker and thesaurus (requires the appropriate dictionary 

files).
· NoteTab Pro: insert up to 10 bookmarks per document.
· Automatic scrolling for hands-free reading of documents.
· Options to set margins, page numbering, headers and footers for printing jobs.
· Text statistics (counts number of characters, words, and frequency of each word).
· Drag-and-drop files from File Manager or Explorer.
· Accepts multiple file names, including wildcards, passed as command-line parameters to the 

program.
· Quickly open files or directories from the Favorites list.
· Can capture text copied to the Clipboard from any application.
· Can read and write files in DOS ASCII, UNIX, and Mac formats.
· And lots more...



Time-saving Features
NoteTab offers many time-saving features. The most important are:

· Editor Clipbook: lets you store and paste any kind of text.
· Favorites: quickly open your favorite files and directories
· Templates: save time in creating many common types of documents.
· Paste Board: copies all text received by the Clipboard into a chosen document.
· Customizable shortcut menu: choose the commands you find most useful for the main shortcut menu.



How to Uninstall
If your copy of the editor came with an installation program (Setup.EXE), you can uninstall it by using the 
Control Panel's Add/Remove Programs dialog box.

The following information is only relevant to users of the distribution package that did not include an 
installation program:

If you have associated file extensions, or set the option to use the registry instead of an INI file, or if you 
have used the command provided to replace MS Notepad, you can easily restore the registry and MS 
Notepad by executing Super NoteTab with the following command-line parameter (note that Super 
NoteTab should not be running when you use this command):

NoteTab.exe /UNINSTALL

If you have dedicated a folder for the editor, just delete that folder and all its files (except documents you 
may have saved there and want to keep!).

Otherwise, just delete all files with the name NOTETAB or NOTEPRO (NOTETAB.* or NOTEPRO.*), all 
files with the extensions ".FVR", ".OTL", ".TPL", and ".CLB", CLIPHELP.CLH, WHATSNEW.TXT, and this 
README.TXT file. All these files are located in the same directory as NoteTab.

If you have executed NoteTab from a CD-Rom, you will find the NOTETAB.INI and NOTETAB.FPR (or 
NOTEPRO.INI and NOTEPRO.FPR respectively) files in the Windows directory.
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Find Help
Almost every menu item, button, and input field in the program offers hint information. Whenever you 
highlight a menu item or place the mouse cursor over a dialog box element, its hint text is displayed in the
program's status bar (at the bottom of the main program window).

If you want to make the most out of NoteTab, read the tips that are displayed in the Tip-of-the-Day 
window. The tips can be selected and copied for future reference.

If the documentation provided with NoteTab does not answer your question, you may find the appropriate 
information by visiting the NoteTab web site at:

www.notetab.com

You will find links to an FAQ list, a mailing list (if there is enough interest), patches, Clipbook libraries 
submitted by other users, and of course information about the latest updates.



Edit Documents
NoteTab lets you open many documents at once and makes them available to you through the tab bar. 
You can configure the tab bar to show or hide the extension part of the name. When you choose the "File 
| New" command, NoteTab automatically creates a name for the new document. You can change the 
format of this name by editing the field "Options | General | New Name Format".

When you modify a document, its little disk icon in the tab turns red. This visual cue makes it easy to 
identify documents that need saving if you want to preserve the changes. When you save the document, 
its disk icon becomes grey again.

You will find many useful commands in the Modify menu that help you process your text. These 
commands make it easy to join or split lines, sort lines, indent or unindent lines, change alignment and 
character case, insert bullets or line numbers, strip HTML tags or convert text to HTML, etc.

NoteTab offers many features and tools to help you write documents efficiently. If used properly, the Editor
Clipbook is probably the feature that will save you the most time. It lets you store and reuse boilerplate 
text which can be anything from a single character to complete multi-megabyte documents. Document 
templates are another time-saving feature. A template is a special kind of document that provides content 
for shaping a new document. You can use several templates to create many common types of documents
such as letters, web pages, etc.

Use the "Tools | Text Statistics" command to get a detailed count of the whole document or highlighted 
text. The dialog box will indicate how many characters and words it found and by clicking on the More 
button, you get the count for individual words.

People often organize their information/notes in individual documents. If you have many such documents,
they can become hard to manage and occupy more space than necessary on your disk. Outline 
documents are the ideal solution in this case. They make it really easy to organize your information in a 
structured format. You can copy the content of each file under its own Outline heading. The result is a 
single document containing all your notes organized into clear and easily accessible categories.

NoteTab lets you view two documents side-by-side by using the "Document | Second Window" command 
(the active document is placed in the right window). With SNT, you can drag-and-drop highlighted text 
between the two windows.

You can customize the editor's main shortcut menu by choosing the commands you find most useful from 
the "Options | Shortcut Menu" list box. Your important commands will be just a mouse-click away. See the 
topic on Keyboard Shortcuts for a detailed list of keys you can use to speed up your work.



Use the Editor Clipbook
You can think of the Clipbook as a visible clipboard with multiple text items that can be pasted in any 
document. The pasteable text item can be anything from a single character to thousands of lines of text. 
Each item is identified by a header which is displayed in the Clipbook window. The header can either 
represent the actual text to be pasted, or a brief description of the text item. A simple Clipbook syntax can 
be used to produce specialized Clipbook items.Thanks to this syntax, the Clipbook can also be used as a 
"Launch Pad" to open URLs and execute other programs (with or without the active document). Such 
items are highlighted in red in the Clipbook list.

To paste a standard Clipbook item, first position the caret in your document, then go to the Clipbook 
window and double-click (or press Return) on the item header. You can also drag-and-drop items from the
Clipbook to your document.

You can copy an item to Window's clipboard by selecting its header and pressing the Ins key or by using 
the shortcut menu. This feature makes it easy to paste Clipbook items into other programs.

There are several options that let you configure the Clipbook to best suit your needs. For example, you 
can dock the Clipbook on the left or right side of the document frame. You can also change the font and 
color used for the Clipbook list box. If the Default Font option is enabled, the list box font will match the 
font used by the active document. You can access all the Clipbook options by invoking the shortcut menu 
from the list box or by opening the Clipbook Properties submenu from the Tools menu.

You can resize the Clipbook list horizontally by dragging the splitter bar (between the Clipbook and the 
document frame).

If you have a long list of Clipbook items or you would like to reduce mouse movement, you can invoke the
In-Context Clipbook. This original feature lets you easily pick Clipbook items directly within your document
at the caret position.

There are two ways to create libraries and add items to the Clipbook. The easiest way to create a new 
library is by invoking the shortcut menu of the Clipbook's library combo box; then use the Clipbook Item 
Editor to create content. Through this menu, you can create a new library, rename the current one, or 
delete it. The other way, is by creating (Tools | Clipbook | New Library) or opening (Tools | Clipbook |    
Open Library) a Clipbook library in the editor. For more information on editing them, see the Clipbook 
Libraries topic.

If you don't want to edit Clipbook libraries directly, you can add new items by selecting text in your 
document and then pressing Ctrl+Shift+C (or selecting Add to Clipbook from the editor's shortcut menu) 
to add it to the current Clipbook library. You will then be prompted to enter a header for the text, after 
which it is added to the Clipbook. If you type a header name that already exists (case sensitive!), the text 
of that item is replaced by the new selected text.

You can also add text from other applications by copying it to Windows' clipboard. Open the Clipbook's list
box shortcut menu and select Add from Clipboard.

The Clipbook is also great as a "shorthand" glossary. For example, if you add the text "Yours sincerely" in 
the Clipbook and give it the header "ys" (without the quotes), then next time you type "ys" in a document 
and hit the F2 function key, "ys" will be replaced by "Yours sincerely". You do not need to type the full 
Clipbook header; just type enough text to match the item you want to use. For example, if you use the 
HTML library and type the letter "c" followed by the F2 key, then the "Center" Clipbook item will be pasted 
in your document. If you frequently use this glossary feature, you may prefer to hide the Clipbook list so it 
doesn't clutter your desktop. Open the Clipbook shortcut menu and choose Hide Clipbook. Just press F4 
if you want to make the Clipbook visible again. If you close the Clipbook instead of hiding it, you will not 



have access to the feature until you reopen it.

The list-box shortcut menu lets you add or edit items, sort the list, save or undo changes, and modify 
configuration options. Note that when you close the Clipbook or change library from the combo box, all 
changes made to the library are automatically saved.

You can toggle between the available Clipbook libraries by pressing the Alt key and a number from 1 to 0 
(0 = 10); the number corresponds to the library's position in the Clipbook's combo box.

Useful Mouse and Keyboard Shortcuts

· Insert copies the selected Clipbook item to Windows' clipboard.
· Delete deletes the selected Clipbook item.
· Enter or Double-click launches a command or pastes the item into the document.
· Ctrl+Space pastes the currently selected Clipbook items.
· Ctrl+Shift+C adds text selected in the document to the current Clipbook library.
· Ctrl+Shift+E opens the Clipbook-item editor
· You can drag-and-drop items to change their order in the list.
· F4 opens or closes the Clipbook.
· Ctrl+G shifts the focus from the Clipbook to the editor.
· Alt+1 displays the first Clipbook library in the combo box list; Alt+2 displays the second, and so on...



Use Web and Document Links
If your text contains an Internet link, holding the Control key down and double-clicking on the link will open
it in your default web browser. If this feature does not work, you will have to fill in the path and file name of
your browser in the "Options | Internet | Default Browser" field. If the editor cannot resolve the URL from 
the text you double-clicked, it will open a dialog box so you can complete the address if necessary.

NoteTab also supports links between documents, Outline headings, and even words within a document. 
These types of links are refered to as "Hyperlinks".

Hyperlinks must be placed between square brackets "[]". You can jump to a hyperlink topic by holding 
down the Control (or Ctrl) key while you double-click on the text between the brackets. Or, if you prefer, 
place the caret anywhere between the brackets and press Ctrl+H to go to the matching topic.

Hyperlinks can be inserted in any kind of document. They can represent a heading in the active Outline 
document, or another Outline document, or the name of a file, or an Internet link, or a line number, or a 
text search criteria. Case is not important unless you use the search criteria feature with case sensitivity 
enabled.

Examples:
* if you activate the [introduction] hyperlink, the content of that Outline topic will be displayed.

*    If you have another Outline file called "Important.OTL", you can create a hyperlink that will display it 
and select the topic you specify. For example, [important.otl::meetings] will display the "meetings" 
heading. Note the use of the double colon to separate the main link criteria from the secondary criteria.

* The accompanying "WhatsNew.txt" file can be opened with this hyperlink: [WhatsNew.txt]

* The following hyperlink [readme.txt::outline] will display the "readme.txt" file. As it is not an Outline file, 
NoteTab assumes the second criteria "outline" is a text criteria to search and will select the first 
occurrence of the word "outline". Note that you will have to specify the full path name if the file is not in 
the same directory as the document containing the hyperlink.

* If you want to apply the search criteria type of hyperlink on the active document, just omit the file name. 
For example, [::NoteTab] will find the next occurrence of the name NoteTab. Since the double colon does 
not necessarily look very nice in this case, the following format with a blank space on each side of the 
search criteria is also valid: [ NoteTab ].

* By default, the search feature is case sensitive, only matches single words, and searches forwards. 
However, you can change this behavior by using extra parameters: "I" indicates that the search should 
not be case sensitive, "T" indicates that any text is acceptable, and "B" tells NoteTab to search 
backwards. Use the "^" character to separate the search criteria from its parameters. For example, 
[ tab^ITB] will select the "Tab" part of the name NoteTab preceding the hyperlink. And 
[readme.txt::NoteTab^B] will find the last occurrence of the word "NoteTab" in the Readme.txt file.

* To jump to a specific line number in a document, the format of the hyperlink is similar to the search 
criteria. You use the line number instead of the search text and use the parameter "L" so that NoteTab 
knows it is the line number you want and not text to search. For example, [readme.txt::5^ L] will display 
the Readme.txt file with the caret at the beginning of the 5th line. If you specify "-1", the caret will be 
placed on the last line: [readme.txt::-1^L]

* URLs are also valid. However, if the link does not start with the typical "www.", then you must fully 
qualify the URL (add "http://", or "ftp://", etc.). The following will connect to the NoteTab site through your 
default web browser [www.notetab.com].





Calculate in NoteTab
NoteTab can also calculate mathematical expressions in a document. These can be of any length. For 
example, if you enter the following expressions in a document:

        Sin(3)*5/Pi=

and then press Ctrl+E (or use the menu command "Tools | Calculate Expression"), the result will be 
added after the equal sign. If there is no equal sign, or if the document is Read-Only then it copies the 
result to the Clipboard and displays it in a small window. You can also add numbers arranged in a column;
just select all the numbers in the following four lines and press Ctrl+E:

23
-5
42
40

Supported mathematical operators and functions are listed below.

Predefined value:
PI

Accepted operators:
+ , - , * , / , ^ , MOD, DIV

The following functions are supported; it doesn't matter if you use lower or upper case:

COS, SIN, SINH, COSH, TAN, COTAN, ARCTAN, ARG, EXP, LN, LOG10, LOG2, LOGN, SQRT, SQR, 
POWER, INTPOWER, MIN, MAX, ABS, TRUNC, INT, CEIL, FLOOR,
HEAV (heav(x) is =1 for x>0 and =0 for x<=0),
SIGN (sign(x) is 1 for x>1, 0 for x=0, -1 for x<0),
ZERO (zero(x) is 0 for x=0, 1 for x<>0),
PH (ph(x) = x - 2*pi*round(x/2/pi))
RND (rnd(x) = int(x) * Random)
RANDOM (random(X) = Random; the argument X is not used)

Acknowledgments:
The mathematics feature was made possible thanks to the superb freeware parsing function developed 
by the following people: Renate Schaaf (schaaf@math.usu.edu), Alin Flaider (aflaidar@datalog.ro), and 
Stefan Hoffmeister (Stefan.Hoffmeister@Uni-Passau.de)



Manage Documents
You can quickly reopen recently used documents by using the "File | Reopen" command. It stores up to 
10 files with the most recently used ones listed at the top.

You can also organize groups of files into projects. You can configure NoteTab to open these 
automatically when you launch the program. The Favorites menu offers many commands that let you 
maintain lists of files and directories.

Use the File List tool to display files stored on your disk or to show the contents of your current Favorites 
Project. You just need to double-click on the file or directoy name to open it.

NoteTab can be configured to reopen your documents as you left them when you last used the editor. Just
set the "Options | General | Reload Open Documents" checkbox.

On the "Options | Files" tab, you have a number of settings that you can adjust to determine where the 
File Open/Save dialog box should point when you open it. For example, if Directory Tracking is enabled, 
the File Open dialog box will point to the same directory as the active document.



Manage File Formats
NoteTab automatically detects the format (DOS/UNIX/Mac) of a text file when you open it. During the 
loading process, UNIX and Mac files are converted to the DOS/Windows format. Through the "Options | 
Documents | Save Format" setting, you can determine what format should be used when the document is 
saved. If you choose Automatic, the original format is restored.

You can open and edit DOS ASCII files in NoteTab. As there is no way the program can automatically 
detect whether a file contains ASCII or ANSI characters, you must specify the format yourself when you 
open the file. By default, NoteTab assumes your files use the standard ANSI character set. See the ASCII 
Documents topic for more details.



ASCII Documents
ASCII is the character set used under DOS and ANSI is used under Windows. If you don't use extended 
characters (such as äèüö etc.), there is no difference between the two. However, if you create a 
document under DOS that uses extended characters and want to display them correctly under Windows, 
the text must be "translated" from ASCII to ANSI in order to display the accented characters correctly. 
Also, if you create a Windows text document (ANSI) and want to use it in a DOS application, it must be 
converted to ASCII if it contains extended characters.

This editor has a built-in filter that makes it easy to edit files of either format. Note, however, that a 
conversion between the two formats may not always translate all characters correctly. There are mainly 
two reasons for this: 1) the extended ANSI characters are not necessarily supported by all font types; 2) 
DOS has many different character sets available which means that extended characters are often quite 
different from one set to the other. The filter used in this program is based on ASCII 850 Multilingual (Latin
I).

By default, the file filter list has an item for opening and saving DOS Ascii files. Since you can change the 
order of the filters and edit them, the program just checks for the word ASCII (case does not matter) in the
selected filter when you use the file dialog box. If it finds the word ASCII, it assumes that you want to open
or save a file in the DOS Ascii format. So if you want to change the default file filters but also want to use 
ASCII documents, remember to put the word ASCII in the description part of at least one of the filter 
items! You can edit the filters by opening the Options dialog box and selecting the File Filters tab.

If you convert a document from ASCII to ANSI and want it to keep its ANSI format permanently, you will 
have to open the Document Properties dialog box and uncheck the Dos ASCII option.



Use Templates
A template is a special kind of document that provides content for shaping a new document. You can use 
several templates to save time in creating many common types of documents.

Templates are slightly different from normal documents in that their first line contains the template header 
definition. The header informs NoteTab that the file being opened is a template; it can also tell NoteTab 
what name it should generate for the new document. For example, the default header looks like this:

= DocTemplate "Notes%0.3d.txt"

You can easily insert a template header in your active document by choosing the menu command " File | 
Template | Add Header".

Headers must always start with an equal (=) sign as the first character on the line followed by the word 
"DocTemplate" (case is not important). After that first part, you can add the text format that NoteTab 
should use to generate the names of documents based on the template. This information is optional and 
must be enclosed in double quotes (") when used. The code "%d" indicates where the incremental 
numbering is inserted in the name. In the above example, the "0.3" between the % and d tells NoteTab to 
format numbers smaller than 3 digits with leading zeroes. If you omit the extension, the currently defined 
default extension will be added when the name is generated. You can also include a path name if you 
always want the documents saved in the specified directory.

Add this type of header on the first line of any document and it will become a template once you save it. 
Then, whenever you open it through the "File | Open" or "File | Template | Open" menu command, a new 
document based on your template will be created. If you need to modify the content of a template, use the
"File | Template | Edit" menu command.



Create Outline Documents
Outline documents make it easy to organize your information in a structured format without using a 
database application or splitting your text into multiple files. An Outline document is composed of two 
parts: the Headings list (or table of contents) on the left and the Contents editor window on the right. 
When you select a heading, its content is displayed in the editor window.

You can have up to about 5400 headings per Outline document and a heading can contain many 
megabytes of information. An Outline file can theoretically have a maximum capacity of 2Gb.

You can create your own outline documents by choosing the "New Outline" command from the File menu.
Unlike standard documents, you must choose a name before it is created. You will also be prompted to 
enter a name for the first heading. Once you have completed those steps, you are ready to enter content 
for your first heading.

To create a new heading, just press Shift+Ctrl+A. You will then be prompted to enter the name for the new
heading. Note that you do not need to save the content of modified headings as you move through the list
- this is automatically taken care of by NoteTab. Shift+Ctrl+D will remove the current topic. If you can't 
remember these shortcuts, just place the mouse cursor over an empty part of the Headings window and 
look at the hint in the status bar. You will find more commands and shortcuts listed in the "Documents | 
Outline Heading" submenu. You can also invoke the shortcut menu from the Headings window.

The PageUp/PageDown keys let you easily scroll from one heading to the next. If the caret is at the 
beginning of the heading's content, pressing PageUp will display the previous heading. Pressing 
PageDown when the caret is at the end of the heading's content will display the next heading. If the last 
heading is already selected, NoteTab will ask you if you want to add a new heading. You can reorder 
headings by simply dragging them with the mouse to a new position.

Just like any other document, you can have multiple Outline documents open simultaneously. Outline files
are very similar to Clipbook libraries and do not contain any control codes other than plain text characters 
(i.e. no binary characters). As a result, you can easily open them in any text editor or word processor 
(although you won't benefit from the outline layout), or send them in E-mail messages.



Create Web Pages
NoteTab has many features that make it easy to create or convert documents to web pages. Note 
however, that only NoteTab Pro offers HTML-syntax highlighting. Support tools include the Editor 
Clipbook, the File List, and the Modify menu which offers powerful commands to convert characters, 
selected text, or entire documents to HTML.

You can produce web pages from Outline documents, complete with a table of contents, headers for each
topic, and links between them. To see for yourself, open the Readme.OTL document and use the menu 
command "Modify | Document to HTML | With Paragraph Tags". Once the new HTML document is 
created, hit the F8 shortcut key to view it in your default browser. Configure the settings on the "Options | 
Outline" tab to configure the format of the web page. Creating this type of HTML document has never 
been easier. Webmasters maintaining FAQ lists will find this feature particularly useful.

The Editor Clipbook is a powerful tool for adding HTML tags to your text. Most HTML editors let you add 
tags through toolbars loaded with buttons or cascading menus. This approach is awkward to say the 
least. With the Clipbook, tags are clearly identified by meaningful names, the list is always in view once 
you open it, and it can contain a virtually unlimited number of items (tags or frequently used text). You can
easily customize the Clipbook HTML libraries to suit your needs. A little icon next to each item indicates 
whether it contains a tag that can wrap around selected text (a "+" symbol) or not (a circle). Some 
Clipbook items even accept user input before they are pasted in the document (see the topic Clipbook 
Wizards for more information). You can insert Clipbook items by double-clicking on them, by dragging 
them into the document, or by typing the first matching characters and hitting the F2 function key. Use 
Ctrl+Spacebar as a shortcut to insert the selected Clipbook item.

Adding links to other web pages or images stored on your computer is really easy when you use the File 
List tool. When it is configured to display disk files or Favorites, file names can be dragged from the list 
into the document. If the extension of the document is listed in the "HTML File Extensions" listbox 
(Options dialog box), the appropriate link tag is inserted at the point where you drop the file.

Changing a URL or any other type of text (even multiple lines) across many web pages is also easy with 
NoteTab. Two methods are available: either you open all the files that are likely to contain the searched 
text and then use the "Search | Replace" command (Ctrl+R) to scan through them, or use the "Search | 
Search Disk" command (Ctrl+D) to scan your disk files.

Use Document Templates to create new documents that already contain the framework of your web page 
layout. This feature will save you a lot of typing when you add web pages to your project. A sample HTML 
template is provided with NoteTab.

You can view your HTML document in your default web browser by using the F8 function key. There is no 
need to save your changes when you use this feature. If NoteTab detects that your document has been 
modified, it stores the changes in a temporary file and sends it to the browser. Temporary files are 
automatically deleted when you exit NoteTab.

You can organize your HTML documents in multiple projects by using the flexible Favorites dialog box 
(Shift+F2). The Favorites feature can exploit an unlimited number of lists (or projects). Items in the list can
represent file names (including wildcards), directories, and the names of other projects. See the help file 
for more information on this feature.



Keep a Log
You can keep a log by using the same method as Notepad. Just add ".LOG" on the first line (without the 
quotation marks) and every time you open such a document, the editor will append the current date and 
time (as specified by your computer's clock).There is an option that lets you configure the format for the 
date and time text that is pasted with the corresponding command. The Date and Time filters topic gives 
you all the codes you can use to build a filter.



Frequently Asked Questions
How do I get rid of the splash screen?

You can disable the splash screen by unchecking the "Show Splash Screen" option in the Options dialog 
box.

Can I replace Notepad with this editor?

Yes! If NoteTab is correctly installed, you will find a command called "Replace MS Notepad" under the 
Help menu. When you choose that command, NoteTab will first rename Notepad by adding the extension 
".MS" to the program file. Then, it will copy a special little program called NOTEPAD.EXE to the Windows 
directory. Whenever this program is executed, it launches NoteTab instead of Notepad. If you want to 
restore MS Notepad after this operation, just use the command "Restore MS Notepad" which is also 
available under the Help menu.

When I save a document as FILENAME.EXT, it becomes FILENAME.EXT.TXT

This behaviour is controlled by Window 95 and NT4. If you use an extension that is not listed in the Save 
As dialog box, the first extension in the currently displayed "Save as type" field is added to the file name. 
To avoid this, type the name between doube quotes "FILENAME.EXT"

How do I specify a default directory for opening and saving files?

There is an option in the Options dialog box on the Files tab that lets you choose the default open/save 
directories.

How do I associate specific extensions with this editor?

There is a tool in the Options dialog box on the Associations tab that makes it really easy to associate file 
extensions or undo associations. Add extensions to the list to create an association or delete an extension
to undo the association.

Why can't I start the editor minimized or maximized?

By changing the properties of a program's shortcut, you can instruct it to start minimized or maximized. 
This will also work with NoteTab. However, if the option "Save Position and Size" is set (see the Options 
dialog box), the program will ignore the shortcut or icon setting and the window will be restored according 
to the last saved position and size.

My Word processor file looks funny in NoteTab and some text is lost!

Files produced by word processors are usually not saved as plain text files. They contain all sorts of 
control codes that only the word processor that created them (or compatible programs) can understand. 
Word processors use those special control characters to store text formatting information (bold, italic, line 
spacing, paragraph alignment, etc.).



The NoteTab editor only understands plain text files (that's why it is so fast compared to a word 
processor) and will display the special control characters as funny symbols or rectangles on the screen. 
Some of the control characters may be interpreted by NoteTab as signaling the end of a file. This explains
why such files are rarely fully loaded in the editor.

Unless you really know what you are doing, you should not edit or save such files with NoteTab. Doing 
this may render them unreadable to your word processor!

How can I set attributes (bold, underline, ...) for individual text elements?

This is not possible with NoteTab (or any "plain text" editor for that matter). This feature would require 
storing special control characters in the document. Since NoteTab is a "plain text" editor, it only saves 
documents as text without any control codes. Therefore all formatting information would be lost when you 
open the document again. If you want to format individual text elements, you will need a more 
sophisticated editor like a word processor.

The icon doesn't stay in the system tray when I close the editor!

Some programs keep an icon in the system tray when you close them. When they do this, many of these 
programs just hide the application window but remain fully loaded in memory - this is very misleading to 
most users! The NoteTab editor also lets you keep its icon in the system tray, however, instead of 
"closing" it to the system tray you minimize it by clicking on the Minimize button. This will hide the 
application window and leave the icon in the system tray for easy access.

Answers to other questions...



Tips and How to...
In Super NoteTab, you can drag-and-drop selected text. To move text to another part of your document, 
first select it, then click on the selection with the left mouse button and drag it to the desired location. If 
you want to duplicate text rather than move it, follow the same procedure but with the Control key pressed
down.

When you have several documents open, you can drag-and-drop page tabs to reorder them any way you 
like.

If you use the system tray and always want the program available, don't exit the editor but minimize it 
instead. The program will minimize to the system tray and reappear next time you click on its icon.

The ruler can display measurements in characters (only accurate with fixed-width fonts), inches, and 
millimeters. Click on the ruler to toggle between the different units. When you place the mouse cursor 
over the ruler, the measurement at that position is indicated in the hint bar. Note that the ruler 
measurements do not scroll horizontally with the editor window.

Use the View | Multiple Instances menu command if you want to open multiple copies of the editor in 
memory.

The Clipbook can be used to launch other programs, open the current document in its associated 
application, open the current document in specified program, and open URLs. Clipbook items with this 
capability are highlighted in red and have a little exclamation "!" symbol on their left side.

Open a local file by placing the caret on its name in a document and pressing the F7 key (or through the 
menu: Tools / Open File at Caret).

The "Go to Line" command is activated when you double-click on the caret-position pane in the status 
bar.

NoteTab Pro: You can toggle between insert and overwrite mode by double-clicking on the 
Insert/Overwrite pane in the status bar.

Double-clicking on the hint line in the status bar selects all the text in the current document.

You can now copy the content of the Clipbook and Outline list to the Clipboard (see the listbox shortcut 
menu). In the Hint bar, you can see how many items are contained in the list when you select the 
"Headers to Clipboard" or "Headings to Clipboard" command.

Pressing the Tab key when you have several lines of text highlighted (starting at the beginning of the first 
line) will now act as if you have chosen the indent command. Holding the Shift key down will unindent the 
highlighted lines.

When the File List is used to display open documents, double-clicking or pressing Enter on a name in the 
list will set the focus to the corresponding document.

Super NoteTab cannot display fonts with OEM character sets (Terminal, MS Line Draw,...). This limitation 
is due to the rich edit control provided with Windows.



Menu Commands
Dialog Boxes
Tools
Other Features



File Menu
Template Submenu
Edit Menu
Search Menu
View Menu
Modify Menu
Lines Submenu
Block Submenu
Change-Case Submenu
Spaces Submenu
E-mail Submenu
Document Menu
Outline-Headings Submenu
Favorites Menu
Organize Submenu
Tools Menu
Clipbook Submenu
Clipbook Properties Submenu
File List Properties Submenu
Help Menu



File Menu
New
Creates a new document. The new name format can be customized by changing the "New Name Format"
field on the General tab of the Options dialog box.

New Outline
Creates a new Outline-type document. This command is not available in the Freeware version of Super 
NoteTab.

Open
Opens an existing document. If the file uses the UNIX or Mac format, it is automatically converted to the 
Windows (DOS) format. You can specify through the "Save Format" field in the Options dialog box on the 
Documents tab how such files should be saved. Choosing the "Original" option restores the original 
format when you save the document.

Reopen
Maintains a list of recently used files. Quickly reopen a recently used file.

Template

Save
Saves the active document. The file format used will depend on the setting in the "Save Format" field in 
the Options dialog box on the Documents tab. Choosing the "Original" option restores the original format 
when you save the document.

Save As
Saves the active document with a new name.

Save All
Saves all the modified documents. This command does not apply to modified Clipbook libraries authored 
through the [Clip] editor.

Export
Saves the text selection or the active document in a different format: ASCII/ANSI, DOS, UNIX, or Mac. 
Using this command on an Outline document will produce a normal text file. By default, headings are 
underlined. This setting can be turned off through the "Underline Headings" field in the Options dialog box
on the Outline tab.

Close Document
Closes the active document.

Close All Documents
Closes all the documents.

Printer Setup
Changes printer and/or printer options.

Print
Prints the active document or selected text.

Print All
Prints all the documents.



Send
Sends the document through electronic mail (MAPI).

Exit
Quits the application; prompts you to save modified documents.



Template Submenu
This submenu can be found under the File menu.

Open
Opens a document template.

Edit
Opens a document template for editing.

Add Header
Adds a template header to the current document.



Edit Menu
Undo
Reverses the last edit action. Undo is not available between Outline headings.

Redo
Redo the previously undone action. This command is specific to NoteTab Pro. It is not available in Super 
NoteTab.

Reload
Reloads last saved version of the current document. This operation cannot be undone!

Reload All
Reloads last saved version of all modified documents. This operation cannot be undone!

Cut
Cuts the selection and puts it on the Clipboard.

Copy
Copies the selection and puts it on the Clipboard.

Paste
Inserts Clipboard contents.

Paste New
Creates a new document and inserts the Clipboard contents.

Delete
Erases the selection.

Clear All
Erases the selection or the entire document if nothing is highlighted.

Select All
Selects the entire document or Outline's current heading content.

Copy All
Copies the entire document and puts it on the Clipboard.



Search Menu
Find
Finds the specified text.

Replace
Replaces specific test with different text.

Search Again
Repeats the last search.

Search Reverse
Repeats the last search in reverse direction.

Quick Find
Finds the next occurence of the highlighted text.

Search Disk
Finds/replaces the specified text in files on the disk. The replace feature is not available in the Freeware 
version of Super NoteTab.

Set Bookmark
Sets or turns off bookmark at caret position. This command is specific to NoteTab Pro. It is not available in
Super NoteTab.

Go to Bookmark
Moves caret to the specified bookmark. This command is specific to NoteTab Pro. It is not available in 
Super NoteTab.

Go to Tab
Activates the specified document tab.

Go to Line
Jumkps to specified line.

Go to Hyperlink
Opens document or heading corresponding to hyperlink under the caret.

Match Brackets
Finds matching bracket.



View Menu
Toolbar
Shows or hides the toolbar.

Ruler
Shows or hides the document ruler.

Clipbook Bar
Shows or hides the Clipbook button bar above the status bar.

Status Bar
Shows or hides the Status bar which displays hint information and the caret coordinates.

Stack Document Tabs
Shows document tabs stacked or unstacked.

Multiple Instances
Allows multiple instances of NoteTab to run.

Icon in System Tray
Minimizes NoteTab to the system tray instead of the task bar.

Stay-on-Top
Makes NoteTab stay on top of other applications.

Printing Options
Sets printing options (margins, font, etc.).

Spell-Checker Options
Sets spell-checker options (dictionaries, correction preferences, etc.). This command is only available in 
the commercial version of NoteTab.

Options
Sets program options.



Modify Menu
Lines

Alignment
Changes the alignment (left/center/right) of selected paragraphs based on the size of the document 
window or column wrap.

Block

Change Case

Spaces

Strip HTML Tags
Use this command to remove all HTML tags from selected text or the whole document. Control and other 
special characters are converted during this process. This command also attempts to format text in tables
by separating each cell with a tab character and by placing each row on a separate line. Use the 
submenu command "Preserve URLs" if you want to keep links.

Document to HTML
Converts highlighted text or the active document to HTML format. Special characters are converted to the
HTML equivalent tag. Choose the "No Paragraph Tags" command if you do not want NoteTab to insert 
<P> and <BR> tags when it encounters new lines. If you apply this command to the whole document, 
NoteTab will create a new HTML page with the header and footer defined in the Options dialog box on the
Internet tab. Outline documents are converted complete with a table or contents and links between the 
topics.

Characters to HTML
This command will convert all extended and special characters (e.g. à, é, ©, <, >) it encounters in the 
selected text (or whole document if no text is selected) to their corresponding HTML syntax. Choose 
"Extended Characters" if you do not want tag elements such as <,>, and " to be converted.

E-mail

Convert to Ascii/Ansi text
Converts document text from ASCII to ANSI character set or reverse. Only extended characters are 
affected by this command.



Lines Submenu
Line commands affect entire lines or word-wrapped paragraphs. This submenu can be found under the 
Modify menu.

Sort
This command sorts the selected lines or the entire document in ascending or descending alphanumerical
order. Use the settings "Case Sensitive Sorting" and "Sort Removes Duplicates" on the Tools tab in the 
Options dialog box to control the result. Depending on the number of lines to sort and the amount of 
available RAM, this procedure may take quite long!

Join Lines
This command joins the current line to the next, or all selected lines together into a single line. Tabs and 
spaces at the beginning or end of such lines are removed.

Split Lines
This command splits a word-wrapped line into individual lines. If word wrap is not enabled, this function 
will determine the length of each line based on the width of the editor window.

Adjust Line Breaks
Use this command on documents (for example UNIX or Mac files) that do not display lines with standard 
carriage return + line feed characters.

Compress
Documents received from web browsers often have a blank line between every normal line, producing a 
double-spacing effect. Use this command to remove this double spacing.

Trim Blanks
This command removes trailing blank and tab characters from the end of the current line or selected lines.

Indent
The indent command adds a specified number of blanks or tabs at the beginning of the current line or all 
selected lines. By default, one blank character is added each time you invoke this command. You can 
choose to use blank characters or tabs, or specify a larger number of indent characters by changing the 
settins on the Tools tab in the Options dialog box.

Unindent
Unindent does the exact opposite of the Indent command.

Insert Bullets
Inserts bullets at the beginning of each line. The bullet character can be changed by editing the "Bullet 
Character" field on the General tab in the Options dialog box.

Number Lines
Inserts numbers at the beginning of each line. NoteTab will prompt you for the starting number. The 
number separator can be changed by editing the "Number Separator" field on the General tab in the 
Options dialog box.



Block Submenu
Although NoteTab is not capable of making rectangular selections, it determines the block coordinates 
based on the selection start and end coordinates. These commands are not designed to operate on word-
wrapped lines. Currently, NoteTab treats tabs as a single character so tab size is not taken into account - 
this feature will be changed in a future version of the program. This submenu can be found under the 
Modify menu.

Cut
Cuts the block selection and puts it on the Clipboard.

Copy
Copies the block selection and puts it on the Clipboard.

Paste
Inserts Clipboard contents at the column position.

Delete
Erases the block selection.

Sum
Adds numbers in the selected columns.



Change-Case Submenu
Case commands only apply to selected text. This submenu can be found under the Modify menu.

Invert Case
Inverts the case of all the selected characters.

Upper Case
Converts all the selected characters to upper case.

Lower Case
Converts all the selected characters to lower case.

Capitalize
Converts the first character of all selected words to upper case and the rest of the word to lower case.



Spaces Submenu
Spaces commands affect either selected text or the whole document if no text is selected. This submenu 
can be found under the Modify menu.

Single Space
Use this command to replace groups of multiple adjacent blank spaces to single spaces.

Single Tab
Use this command to replace groups of multiple adjacent blank spaces to single tabs.



E-mail Submenu
These commands affect either selected lines or the current line if no text is selected. This submenu can 
be found under the Modify menu.

Quote Text
Adds E-mail quote character(s) at the beginning of lines. The default quote character is ">". It can be 
changed by editing the "EMail Quote" field on the Internet tab in the Options dialog box.

Remove Quotes
Removes ">" E-mail quote characters from the beginning of lines.



Document Menu
Properties
Sets active document properties

Default Properties
Use default settings in active document as defined in the Options dialog box on Documents tab.

Auto Indent
Enables or disables auto-indentation.

Word Wrap
Sets or turns off word wrap in active document.

Update Column Wrap
Updates lines in current document so that they wrap at defined column. This option is only available in 
Super NoteTab and is enabled when the column wrap option is set for the current document. NoteTab Pro
does not need this feature because it handles column wrap in real time.

Font
Change the current document font, or Increase/decrease its size.

Insert File
Inserts specified file at caret position.

Insert Date/Time
Inserts current date and time at the caret position.

Insert Document Name
Inserts active document name at caret position.

Insert Page Break
Inserts a page break character at the current line.

Outline Headings
This menu is not available in the Freeware version of Super NoteTab.

Second Window
Shows active document in secondary window pane.

Use as Paste Board
Makes active document capture all Clipboard text cut and copy operations.

Rename
Renames active document.

Delete
Deletes active document. Erases corresponding disk file if it exists (the deleted file goes to the recycle 
bin).

Read-Only
Sets or turns off the read-only status of the active document.



Outline-Headings Submenu
Add Item
Adds a new outline item (heading).

Remove Item
Deletes the active outline item (heading).

Edit Heading
Lets you edit the current outline heading.

Sort Headings
Sorts outline headings in ascending order.

Move Next
Moves to the next heading.

Move Previous
Moves to the previous heading.

Move First
Moves to the first heading.

Move Last
Moves to the last heading.



Favorites Menu
Projects
The "New Project" command creates a new Favorites list. All available projects are listed below that 
command and a checkmark highlights the current list. Choosing a project from the list makes it current. 
You must reopen the Favorites menu to see the new content or use the Files List tool.

Organize



Organize Submenu
This submenu can be found under the Favorites menu.

Add Favorite Document
Adds active document name to the Favorites list.

Add all Documents
Adds all open documents to the Favorites list.

Add Favorite Folder
Adds path name of active document to the Favorites list.

Go to Favorites
Shows the Favorites dialog box.



Tools Menu
Clipbook

Clipbook Properties

Expand Text
Replaces abbreviation at caret position with matching Clipbook replacement text.

File List
Shows or hides the File List box.

File List Properties

Open File at Caret
Opens document matching file name at caret position.

Launch Document
Launches active document in application defined in the "Custom Launch" field on the Tools tab in the 
Options dialog box. This command is disabled if no application is defined.

View in Browser
Shows active document in web browser.

Alternative Browser
Shows active document in user-defined web browser. The browser application is defined in the "Second 
Browser" field on the Internet tab in the Options dialog box. This command is disabled if no browser is 
defined.

Open Link
Opens link in web browser.

Auto Scroll
Starts automatic scrolling for hands free reading of active document.

Calculate Expression
Calculates selected mathematical expression.

Text Statistics
Shows detailed character and word count for selected text or whole document.

Spelling
Checks the spelling in active document. Checking starts from the caret position. If text is selected, spell 
checking is applied to the selection only.

Thesaurus
Checks thesaurus for word at caret.



Clipbook Submenu
This submenu can be found under the Tools menu.

Open Clipbook
Opens or closes the Editor Clipbook. May remain hidden if configured that way.

Paste Current Item
Pastes the currently selected Clipbook item.

Copy Selection
Copies selected text to the Current Clipbook library.

Cut Selection
Cuts selected text to the Current Clipbook library.

Clipbook Item Editor
Shows content of currently selected Clipbook item in dedicated document window.

Open Library
Opens a Clipbook library as a standard document.

New Library
Creates a new Clipbook library and opens it as a standard document.

Show Clip Assistant
Shows the Clip Assistant in place of the File List.



Clipbook Properties Submenu
This submenu can be found under the Tools menu.

Dock Left Side
Docks Clipbook window on left side of document.

Dock Right Side
Docks Clipbook window on right side of document.

Hide Clipbook
Hides Clipbook window. Expand Text function remains available as long as the Clipbook is open.

Font
Set Clipbook font.

Background Color
Set Clipbook window background color.

Match Document Font
Sets Clipbook font to match active document font.

Show Headers
Set this option to display Clipbook headers in the dedicated Clip editor window.



File List Properties Submenu
This submenu can be found under the Tools menu.

Show Full Name
Shows file names with path or without.

Font
Sets File List font.

Background Color
Sets File List window background color.

Documents
Shows all open document names in File List window.

Favorites
Shows Favorites in File List window.

Disk Files
Shows disk files matching specified criteria in File List window.



Help Menu
Help Topics
Opens the Help Topics window.

Search for Help on
Searches for a help topic.

Show Tip of the Day
Shows Tip-of-the-day dialog box.

Readme File
Shows NoteTab's "Readme.txt" file.

What's New
Shows NoteTab's "WhatsNew.txt" file.

HTML Help
NoteTab makes the popular "The HTML Reference Library" (by Stephen Le Hunte) available from the 
Help menu when you install the package in the same directory as NoteTab. You can download the 
excellent "HTML Reference Library" from:
            http://subnet.virtual-pc.com/~le387818/
This menu command is only available once the "HTML Reference Library" is installed.

HTMLib Colour Wizard
This command activates the "HTMLib Colour Wizard" utility developed by Stephen Le Hunte. This menu 
command is only available once the "HTML Reference Library" is installed.

Replace MS Notepad
Once this command has been activated, it causes NoteTab to execute whenever MS Notepad is invoked.

Restore MS Notepad
Reverses the changes made by the "Replace MS Notepad command.

Ordering Information
The Order form dialog box makes it easy to purchase the commercial version of NoteTab. This command 
is only available in the Freeware version of Super NoteTab and the trial version of NoteTab Pro.

About
Displays the NoteTab "About" dialog box.



Export Dialog Box
Print Dialog Box
Find & Replace Dialog Boxes
Search Disk Dialog Box
Favorites Dialog Box
Text Statistics Dialog Box
Document Properties
Customizing the Toolbar
Options Dialog Box



Export Dialog Box



Print Dialog Box
Most settings in the Printer dialog box are saved and restored when you run the program again. However,
each time you move to another document, the Title text is replaced by the document's name and Print 
Word Wrap is checked.

If you choose to print a document to a file, the lines will be wrapped at the same point as if they were 
printed on paper and page breaks are inserted accordingly. The resulting file has the same name as the 
document but has the extension PRN; it is created in the same directory as the document.

By default, the document font will be used for printing. You can, however, choose a printer font that is 
used instead of the document font. This option is available on the Font tab.



Find & Replace Dialog Boxes
If the selected text is between 2 and 255 characters long, it is placed in the Find field of the dialog box 
when it is opened (special characters are automatically replaced by their respective tokens – see below). 
Otherwise, the last searched item is displayed displayed in the field. The maximum length for a search or 
replace text is 255 characters. Searching always starts from the caret position!

The Find and Replace dialog boxes accept tokens to represent special characters:

          ^T = Tab ($09)
          ^B = Page break ($12)

The following are not available in NoteTab Pro:

          ^P = Paragraph (carriage-return/line-feed pair)
          ^C = Carriage-return ($0D)
          ^L = Line-feed ($0A)

If you actually need to search characters that correspond to one of the tokens, just precede it with an 
extra ^ symbol (for example ^^T to search for ^T).

When the editor is configured to "stay-on-top", the Find and Replace dialog boxes are modal. In other 
words, you cannot return to the editor until you close the dialog box. When the program is not "stay-on-
top", they are modeless (you can edit documents while the dialog boxes are open).

You can increase the width of the dialog box if necessary and save the new size by opening its Control (or
System) menu and clicking on Save Window State.



Search Disk Dialog Box



Favorites Dialog Box
Many Windows users, like myself, have lots of text files stored in many different places on the hard disk. 
Using the file dialog box to search for them and open them can become a time consuming task. That's 
why I created the Favorites dialog box.

The Favorites dialog box makes it easy to quickly open any file or a directory (folder) you have added to 
the list. You can easily add new files and directories to the list using the integrated editor or by clicking on 
the Add button. The Add button opens the file dialog box from which you can select multiple files. The 
integrated editor also lets you add file names with wild cards. This is handy if, for example, you want to 
open all your HTML files in the editor to perform a global search and replace operation:

C:\Web\Homepage\*.html

I recently used this feature to open about 130 HTML files to perform a global search and replace 
operation. The Favorites dialog box really makes the task easier.

By clicking on the New button, you can enter file names or directories in the input field (below the list box) 
without using the File dialog box displayed by using the Add button. You can also use that method to 
specify file names with wild cards.

When you add a directory name to the list, make sure it ends with a backslash "\" (otherwise it will be 
interpreted as a file name). When you open a directory item, the File Open dialog box is displayed 
pointing to the selected directory. If several items are selected in the list, directory items are ignored when
you choose the Open or Open All button. For example, when opening the following item, the File Open 
dialog box will pop up and show the content of the Homepage directory:

C:\Web\Homepage

You can create separate lists for all kinds of different tasks. The names of all available lists are displayed 
in the list name combo box. Favorite Files lists are always stored in the program directory and have the 
extension FVR. These are text files that can also be edited in the editor like any other file. You should not,
however, edit such a file if it is currently open in the Favorites dialog box.

You can also specify other "Favorite Files" list names by clicking on the New button in the dialog box, then
typing a colon character (:) followed by the list's name. For example:

:Favorite
Once you have created such an item, double-clicking on it will open all the files in that list.

You can reorder the list using drag-and-drop or sort the list by invoking the shortcut menu. You can select 
multiple files in the list and open them by clicking on the Open button. If you want to open all the files in 
the list, just click on the Open All button (in this case, directory items are ignored).

The shortcut menu also lets you undo any changes you have made to the list. Changes are permanently 
saved when the dialog box is closed or when a new list is selected from the list names combo box. You 
can create new lists by invoking the combo box shortcut menu. This menu also lets you rename lists or 
delete them.

The editor can be configured to open all the files from a Favorite Files list whenever you start it. If you 
want to open files from a different list from the one that was last used, you can specify its name from the 
command line.

The dialog box size and position can be saved by opening its Control (or System) menu and clicking on 
Save Window State.





Text Statistics Dialog Box
The Text Statistics dialog box provides information on the number of characters, words, and the number 
of occurrences of each different word within a text. If you select text, that information will be extracted 
from that portion of the document. If no text is selected, then the whole document is analyzed.

The first part of the dialog box displays the following fields:

· Characters The figure is based on the total number of characters encountered in the text, including 
spaces and tabs. Each tabs counts as one character only.

· Words Only words composed entirely of alphabetic characters are counted here.

· Others Any word that is not counted in the previous field is added here. For example numbers 
or words that are a mix of alphabetic characters and numbers.

To display the frequency of occurrences of individual words, click on the More button. Depending on the 
size of the text to analyze, this process may take some time to display the result. At the end of the list, you
can read the total number of different words encountered in the text. If you want to copy the list to the 
clipboard, invoke the shortcut menu by right-clicking in the list.



Document Properties
This dialog box lets you set properties for individual documents. You can define word wrap, tab width in 
pixels, font name and size, and character set for the currently selected document. If the Default option is 
checked, the settings defined in the Documents tab of the Options dialog box are applied.

Word Wrap: Enables word wrap at window edge or specified width if Wrap to Column is enabled.

Wrap to Column: When you enable this option, word wrap occurs at the specified column position (in field 
next to check box) instead of the Window margin.

Auto Indent: When enabled, a new paragraph created by pressing <Enter> or <Ctrl+Enter> is given the 
same indentation level as the last line of the previous paragraph (this is generally useful only when word 
wrap is off).

Trim White Spaces: When enabled, spaces at the end of a paragraph are removed when it is added to the
document.

Scroll Past End of Line: If this option is enabled, the caret can move beyond the end of the current line. If 
it is disabled, pressing <Right> when the caret is at the end of the line moves the caret to the beginning of
the next line. This option is ignored if word wrap is on.

Tab Size: Tab characters in the document are expanded to spaces (visually). The number of spaces used 
is a function of the contents of the line and the current tab size, which can be changed by setting a new 
value in this field.

Type of tab: You can change the behavior of the editor by changing this option. If the tab type is set to 
Real, pressing <Tab> inserts a "real" tab character into the document. If the tab type is set to Fixed, 
pressing <Tab> inserts enough spaces to move the caret to the next tab stop. (This is called "fixed tabs" 
because the position of existing text will not change if the tab size is later changed, as it does if real tabs 
are used.) If the tab type is set to Smart, spaces are also inserted into the document, but the positions of 
the tab stops are a function of the positions of the words in the previous line.

Dos ASCII: This option is only available in the Document Properties dialog box. Changing this option will 
affect how the document is saved. If you want to convert the current text between ASCII and ANSI, use 
the "Convert to Ascii/Ansii Text" command under the Document menu. So, for example, if you convert an 
ASCII document to ANSI and want it to stay this way, just uncheck the DOS ASCII option; next time you 
save the file, it will keep its ANSI format.

Automatic: When you set this option, the file format (PC,UNIX,MAC) is automatically detected when a 
document is opened and restored when it is saved. In other words, if you open a UNIX document, modify 
it and then save it, the updated file retains its original UNIX format. Note that this option may slow the 
loading of large files.

UNIX Format: This option tells the editor to save a document in a format that is compatible with the UNIX 
operating system (all carriage return / line-feed pair are converted to LF).

Font: You can change the document font by clicking on the font button. This will open the standard font 
dialog with all the fixed-width fonts available on your system.

Document Properties are saved whenever the document or the editor is closed. All settings for up to the 
256 most recently opened files are stored in a file called FILEPROP.DAT which is placed in the program 
directory. You can edit the NOTEPRO.INI file (the editor must not be running!) and set another value for 



the MaxStoreProperties item under the [Options] section. You can clear all memorized settings by 
choosing the Clear Properties command on the Advanced tab of the Options dialog.



Customizing the Toolbar
You can configure many aspects of the toolbar. There is a large choice of commands you can display in it 
and you can reorder any button to suit your way of working. The toolbar properties are available through 
the Toolbar shortcut menu (right-click with your mouse on the toolbar) or by opening the Options dialog 
box and selecting the Toolbar tab.

Show in Toolbar: This list shows all the available toolbar buttons. By clicking in the check box in front of 
each button description, you can make it visible or remove it from the toolbar. Use the Separator items to 
separate groups related buttons. You can easily reorder buttons and separators by clicking on their 
caption and dragging them to a new position. Alternatively, you can select a button item and use the Move
Up and Move Down buttons to change its position.

Note that if you choose to display the Close Document button, the "Quick Close" button normally 
displayed on the far right side of the toolbar is removed.

Regular Buttons: When checked, the toolbar shows the standard "extruding" buttons. Otherwise, the new 
flat buttons (Office 97) are displayed.

Show Caption: Use this option to display captions in the buttons. The width of these buttons is 
automatically determined by the size of the longest caption.

Show Tool Tips: Tool Tips appear when you place the mouse cursor over a toolbar button. You can 
disable this feature by turning this option off.

Show Separators: If you have set the Regular Buttons option, separators add blank space between the 
buttons where they are placed. With the flat buttons, separators are displayed as chiseled vertical lines. If 
you do not want to display separators, just disable this option.

Wrap Buttons: If this option is set and the editor window is too small to display all the buttons, the toolbar 
will resize itself and wrap the buttons to the next line.

Caption Font: This button opens the Font dialog box and lets you change the default font used for the 
toolbar button captions.



Options Dialog Box
This dialog box lets you configure the main program settings. Use the Options command under the View 
menu to open this dialog. The settings are automatically saved when you quit the editor and used when 
you start the program again.

General Tab:

Save Position and Size: when you enable this option, the editor will always restore its previous position 
and size when you start it.

Reload Open Documents: Use this option if you want the files that were open when you closed the editor 
to be reopened next time you start the editor. Files that no longer exist are now ignored.

Load Favorites on Startup: Loads the files listed in the Favorite Files list (from current list or an alternative
list indicated through the command line) whenever you start the editor.

Directory Tracking: The working directory follows the active document when this option is enabled.

Allow Multiple Instances: Set this option if you want to allow multiple instances of the editor in memory.

Find Text at Caret: If the caret is placed within a word, opening the Find or Replace dialog box will insert it
in the Find field. If this option is not enabled, you have to select the word yourself to insert it in the dialog 
box.

Save Files on Close: if this option is enabled, the editor will no longer prompt you to confirm whether a 
modified file should be saved before it is closed. Note, however, that the File Save As dialog box is 
displayed if the file does not have a name or if it is Read Only on the disk.

Make Backups: When this option is enabled, the editor always attempts to make a backup copy of a file 
before it is overwritten by a new version when you choose the save command.

Backups use .BAK: When this option is enabled, backup files receive the .BAK extension. Otherwise, a 
tilde '~' is inserted between the dot and the file's extension.

Stay On Top: you can make the program stay on top of others by enabling this option. When you choose 
this configuration, the Find and Replace dialog boxes cannot be modeless. Also, it is not recommended to
maximize the editor when this option is checked. If another program needs to display a message, the 
editor will usually loose the focus to a window that is masked by itself.

Icon in System Tray: When enabled, the editor's icon is placed in the system tray instead of the task bar.

Show Main Menu: When enabled, the main program menu is displayed.

Show Toolbar: When disabled, the program toolbar is hidden.

Show Ruler: When disabled, the document ruler is hidden.

Show Status Bar: When disabled, the program status bar is hidden.

Show Caret Position: When disabled, the caret-position panel is removed from the status bar. This leaves 
more space for the hint text.

Show Ext. in Tabs: When disabled, the file name that appears in the document tab is displayed without its



extension.

Show Splash Screen: Shows the splash screen when you start the program.

Highlight URLs: When enabled, any document that does not highlight HTML tags will highlight URLs. 
Turning this option off will increase the speed of screen updating (only noticeable on slower systems).

Highlight HTML Tags: When enabled, any document with an HTML extension (listed in the HTML File 
Extensions list - see Advanced tab) will highlight HTML tags. Turning this option off will increase the 
speed of screen updating (only noticeable on slower systems). If the default extension (see File Filters 
tab) corresponds to an HTML extension, then new documents will also highlight tags.

Documents Tab:

The options you set on this tab define the default document properties that will apply to all newly opened 
documents and those that have the Default option checked. You can define word wrap, automatic 
indentation, tabulator width in pixels, font name and size, etc.

File Filters Tab:

This tab provides a little editor that lets you define the file filters that are used in the File dialog boxes. You
can edit, delete and add new descriptions and wildcards, reorder them by using the Move Up / Move 
Down buttons or by drag-and-dropping items in the list. Note that there is a limit to the number of items 
you can create.

By default, the file filter list has an item for opening and saving DOS Ascii files. The program checks for 
the word ASCII (case does not matter) in the selected filter when you use the file dialog box. If it finds the 
word ASCII, it assumes that you want to open or save a file in the DOS Ascii format. So if you want to 
change the default file filters but also want to use ASCII documents, remember to put the word ASCII in 
the description part of at least one of the filter items!

The default extension field is also used by the file dialog box.

Colors Tab:

You can set the background color of documents and the color of text by clicking on the Background and 
Normal Text buttons respectively. To change the color of selected text, use the Highlight Back and 
Highlight Text buttons. To change the color used to highlight HTML Tags and URLs, click on the HTML 
Tags and URL Text buttons respectively. Use the Highlight Tags button to change the color of HTML tags 
and URLs when they are selected.

If you also want URLs underlined, put a check mark in the Underline URLs check box.

To reset all colors back to the Windows standard colors, just click in the Use Default Colors check box.

Toolbar Tab:

See the topic Customizing the Toolbar for an explanation of the options.

Advanced Tab:



Web Browser: This field should only be used if the editor is unable to start it when you choose one of the 
web enabled functions. When you enter a browser name (path and file name), the editor will execute the 
browser according to this information. As a result, a new instance of the browser may be loaded each 
time you choose to display a link or document. When this field is left empty, the editor will try to retrieve 
information from the Windows registry and communicate with your browser using DDE. If this method is 
successful, the editor can detect if an instance is already loaded in memory and send the appropriate 
commands to the browser.

Date Filter: The date filter is used by the Insert Date menu command and the Log feature. If you leave this
field blank, the short date format defined in your Windows setup is used. The Date and Time filters topic 
gives you all the codes you can use to build a filter.

HTML File Extensions: This list is used by NoteTab to identify which documents require HTML tag 
highlighting when this feature is enabled. If a document has an extension that matches one of the entries, 
then highlighting is performed. Use the Add button to insert new extensions and the Delete button to 
remove the selected item.

Show Prompts: When this option is enabled, you will be prompted for confirmation when you choose to 
reload or delete a document.

Filter Binary Codes: If a file contains special control characters (any character with a decimal value of 0 or
8), these are automatically converted to '·' (Alt+0183). When set, you can see the full content of any type 
of file. Note that saving this kind of file will not restore the control characters (only do this if you know what
you are doing)! This option slows the loading of large files, so don't set it if you use only real text files.

Clear Properties: Use this command to clear all the stored document properties. Next time you open this 
documents, the default settings defined in the Options dialog box are used. This command has no effect 
on open documents.

Indent Size: The value is used to indicate the number of blank spaces used to increase or decrease the 
indent of selected lines (Line Indent /Unindent commands).

Undo Limit: You can configure the size of the undo buffer through this field. The value is in bytes and 
cannot exceed 65'532 (64 Kb). By setting a smaller value you save system resources. This is only useful 
if you intend to open a very large number of documents at once. This option will not change the buffer 
size of documents that are currently open.

Undo after Save: Allows an undo operation after a modified document has been saved.

Text Limit: You can configure the maximum document size the editor open. The value is in bytes and 
cannot exceed 16'777'216 (16 Mb). Choosing a lower value will save system resources. This option will 
not change the buffer size of documents that are currently open.

Paragraph Limit: You can configure the maximum paragraph length allowed in documents. When word 
wrap is turned off, a paragraph represents a single line. The length is measured in characters and cannot 
exceed 32'767 (32 Kb). Choosing a lower value will save system resources. This option will not change 
the paragraph size limit of documents that are currently open.
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ASCII

A document can be opened and saved using the ASCII character set. See the ASCII Documents topic 
for more details.

UNIX/Mac
When you open a UNIX or Mac file, NoteTab automatically translates line breaks to the Windows 
format. If you want the original format restored when you save such documents, set the "Save Format"
option to Original. You can also choose to have files always saved in the UNIX or Mac format. There is 
also an Export command under the File menu that lets you save a document or selected text in a 
different format without changing the active document.
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File List
The File List feature makes it easy to find a specific editor document when a large number of them are 
open. It displays the document names (path and file name) in alphabetical order. Just click on a document
name to make it appear in the editor window.

When selecting a document in the window, the focus does not shift to the editor. To do so, you now must 
double-click on the document name or press the Enter key.

The File List's shortcut menu lets you close, delete, or shift the focus to the selected document, or close 
the window.

Useful Mouse and Keyboard Shortcuts

· Delete closes the selected document.
· Enter or Double-click shifts the focus to the selected document.
· Ctrl+G shifts the focus from the File List to the editor.



Paste-Board Feature
Any document in the editor (as long as it is not Read-Only) can be configured to capture text that is cut or 
copied to the Windows Clipboard. First select the document you want to use as a "paste board", then 
activate the "Use as Paste Board" option in the Document menu. As long as this option is active, the 
document will capture and append all text sent to the Clipboard from any Windows application (including 
the editor itself). The computer speaker will play a sound each time the paste-board document captures 
some text.

The paste-board feature, for example, makes it easy to create a list of links or important information you 
copy as you surf the web.

Note that only one document at a time can act as a paste board. When you activate this option on another
document, the previous paste-board document stops capturing Clipboard text.



Automatic Scrolling
Automatic scrolling allows hands-free reading of any document. You can set the speed in characters per 
second and the program will scroll through the text one line at a time until it reaches the end. The Auto 
Scroll command is available in the Tools menu.

The Auto Scroll "command center" dialog has five buttons and an input field that lets you set the scroll 
speed in characters per second. This dialog is modal, so you cannot return to the editor unless you close 
it.

For left to right, the buttons are...

· Play: Starts scrolling at the speed defined by the Speed field.
· Quit: Stops scrolling and closes the dialog box.
· Pause: Stops scrolling
· Rewind: Same as Page Up (pressing this button pauses scrolling)
· Forward: Same as Page Down (pressing this button pauses scrolling)

You can also use the keyboard to control scrolling... 

· Spacebar: Toggles between Play and Pause mode.
· Page Up: Same as Rewind button.
· Page Down: Same as Forward button.
· Esc: Stops scrolling and closes the dialog box.

If you edit the scroll speed while the document is scrolling, the pause button will be activated and you will 
have to press the Play button to continue scrolling at the new speed.
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In-Context Clipbook
You can invoke the "In-Context Clipbook" by hitting the ESC key while you work in a document. Doing so 
will display a combo box (filled with the content of the active Clipbook library) at the caret position. 
Selecting an item from the combo box will then paste the Clipbook text in your document. Typing in the 
combo box will automatically scroll to the first item matching the characters entered. Press ENTER or 
double-click to confirm your choice. You can choose a different Clipbook library by invoking the combo 
box shortcut menu. To cancel the "In-Context Clipbook", just hit the ESC key or click with the mouse in 
another part of the editor.



Clipbook Libraries
You can easily edit or create your own Clipbook libraries directly in the editor. Choose Open Library from 
the Tools | Clipbook menu to edit an existing library, or New Library if you want to create a new one.

The library format is very simple and I suggest that you look at some of the samples provided with 
NoteTab. Basically, there are two possible formats:

The simplest format has one text item per line and the header just duplicates the content. Empty lines are 
ignored.

The second format can have multi-line text items and each item can be identified by a descriptive header. 
This format must start with an equal sign (=) on the first line, followed by the text "MultiLine" (without 
quotes, character case does not matter). Each pasteable text item must be separated by an empty line. If 
you want to specify a header, add "H=" (without the quotes) followed by your header. The header must be
directly on the line above the item it describes.

By default, headers are sorted in the Clipbook window. If you don't want the them to be sorted, place the 
text "NoSorting" (without quotes, character case does not matter) on the first line after the comma (this 
command applies to both library formats).

When you save a Clipbook library, the Clipbook window is immediately updated. You can create as many 
libraries as you like; they will all appear in the Clipbook combo box.

I you have created Clipbook libraries that may benefit other users, why not send me a copy! I'll be glad to 
add them to the Clipbook repository at my web site.

Each library can have up to about 5440 Clipbook items, and you can have up to 5440 libraries.

For details on more advanced features, see the topic on Clipbook Syntax.



Clipbook Syntax
You will find information about the following topics:

· Wrapping a Clipbook item around selected text
· Adding prompts in a Clipbook item
· Using date filters in a Clipbook item
· Using the Clipbook to launch other programs
· Inserting comments in a Clipbook item

Wrapping a Clipbook item around selected text

Normally, if you select text in your document and then paste an item from the Clipbook, the document 
selection is replaced by the Clipbook text. However, if the Clipbook text item includes the two-letter code 
^&, the highlighted text in the document is inserted at the code's position and the resulting text is pasted 
in the document. This feature is particularly useful when producing HTML documents. For example, if you 
have defined a Clipbook item under the title Italic:

<I>^&</I>

Selecting text in your document (for example NoteTab) and then double-clicking on the Italic item in the 
Clipbook will surround the text with the italic tags:

<I>fabulous</I>

Adding prompts in a Clipbook item

Sometimes, you may want to complete a Clipbook item just before it is pasted in your document. HTML 
tags are a good example where this could come in handy. If you use the sample HTML library that comes 
with this program, you will notice that when you double-click on the Font item, the program will display a 
dialog box prompting you to enter a value for the font size. You have a choice to type a value or pick it 
from a combo box.

Adding this type of behaviour to a Clipbook item is very easy. Simply place the two-letter code ^? in your 
Clipbook item at the position where user input should be inserted. For example, when you double-click on
a Clipbook item with the following text:

<FONT SIZE=^?>

a dialog box with a plain input field will prompt you to complete the Clipbook item. The user input replaces
the two-letter code, and then the completed tag is copied to the document. If you would like the prompt to 
be a bit more descriptive, you can specify the text that will be displayed in the dialog box by placing it 
between square brackets:

<FONT SIZE=^?[Font size]>

You can define a default value that will be displayed to the user. Just add an equal sign after the prompt 
followed by the default text. The following example will show the value 12 in the input field of the dialog 
box:

<FONT SIZE=^?[Font size=12]>



You can produce more sophisticated prompts by offering the user a list of choices. When the program 
detects this type of prompt, it displays a dialog box with a combo box. To specify a list of choices, use an 
equal sign "=" after the prompt text followed by the values. Use a "|" (Alt+0124) as a separator between 
the values. For example, the following item will show a combo box labeled "Font size" with the values 8, 
10, 12, 14, 18, 24, and 36 in the list:

<FONT SIZE=^?[Font size=8|10|12|14|18|24|36]>

The user can also enter values that are not listed. If, however, the input should be limited to the values 
available in the list, just double the comma sign as in the following example:

<FONT SIZE=^?[Font size==10|14|18]>

If you would like to select a default value when the dialog box is displayed, just place an underscore 
character "_" in front of the desired value. In the following example, the value 10 will be used as the 
default value:

<FONT SIZE=^?[Font size=8|_10|14|18]>

You can display in the combo box list a different text from what you actually want to use. Use the ^= code 
to separate the text to display (on the left side) from the text to use (on the right side). The example below
will show a combo box with three items in the list: Small, Medium, Large. The medium item will be 
selected as the default value since it starts with an underscore character.

<FONT SIZE=^?[Font size=Small^=6|_Medium^=10|Large^=14]>

A Clipbook item can have as many prompts in it as you like. If you repeat a prompt within the same 
Clipbook item, the initial answer entered by the user is inserted in its place (the dialog box is not displayed
again). In the following example, the user will only be prompted once:

Dear ^?[First Name=Lisa|Bill|Jane|Ted],
How are you ^?[First Name]?

Notice that it is not necessary to duplicate the whole prompt item, but only the prompt header. Suppose 
the user chose Jane, this is what will be pasted in the document:

Dear Jane,
How are you Jane?

Using date filters in a Clipbook item

If you want to use date/time filters in the Clipbook, use ^[ and ^] to delimit the filter element of the 
Clipbook text. For example, if you add the following text to the Clipbook:

This message was written ^[dd/mm/yyyy^]

Pasting it in a document will produce the following text (assuming the date is 22 February 1997):

This message was written 22/02/1997

Using the Clipbook to launch other programs



Any Clipbook item that starts with the two-letter code ^!, will be launched when invoked. For example, 
double-clicking on a Clipbook item with the following text:

^!calc.exe

will execute the calculator provided with Windows. Note that if the application is not in the search path, 
you will have to add the fully qualified path to the application you want to use.

A Clipbook item can behave a bit like a batch file in that it supports multiple commands - each on a 
separate line. For example, if you have a Clipbook item with the following instructions:

^!calc.exe
^!write.exe "c:\My Documents\MyFile.Doc"

Executing it will open both the calculator and the word processor. You can control the timing for opening 
consecutive applications. The instruction ^!WAIT will wait until the previously launched application has 
closed before executing the next command. You cannot use the editor when it is in Wait mode (the 
editor's window caption indicates it is waiting for the application to close). The instruction ^!PROMPT will 
display a dialog box prompting the user to click on the OK button before passing on to the next 
instruction(s). In the following example, the Write program will only be launched once the Calculator 
program has been closed:

^!calc.exe
^!WAIT
^!write.exe "c:\My Documents\MyFile.Doc"

Note that the ^!WAIT command may not work with all applications (during testing, it did not work with the 
MS-Write program).

If you want to open the current document in another application, use the three-letter code ^** to indicate 
where the document name should be inserted in the command line. For example, if you want to open the 
current document in MS-Write, you would use the following command:

^!write.exe ^**

To specify a document name without its extension, use the following two-letter code instead: ^*

Documents that have not been saved are stored in a temporary file when this type of command is used. 
The temporary file is then substituted for the document name. You can also specify additional parameters 
that your application recognizes. Here is an example that will do a syntax check on a Perl script 
(assuming it is the current document in the editor):

^!perl -c ^**

If you are editing a document that is associated with another application, you do not need to specify the 
application name. For example, if you are using an HTML document (with the appropriate extension!), the
following command will open the current document in the browser that has been associated with HTML 
extensions:

^!^**

Note that the ^!WAIT instruction only works with launch commands that include the program name. It will 
not work with the example above!

You can also open URLs in the associated browser. To do so, the two-letter code ^! must be followed by 
the following text "URL:" (without the quotes). For example, the following command will open the link to 



my Homepage:

^!URL:http://www.unige.ch/sciences/terre/geologie/fookes/

You will find more examples in the Clipbook library sample LAUNCH.CLB which is provided with the 
editor.

Inserting comments in a Clipbook Item

Inserting comments in a Clipbook item is very easy: just place a semicolon (;) at the start of each line 
containing a comment. If you come across a situation when a line in a Clipbook item should start with a 
semicolon and it is not a comment, just add an extra semicolon in front of it. Please note that comments 
are only valid within a Clipbook item!
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Editor Shortcut Menus
Click with the right mouse button on the document and you will have access to a customizable shortcut 
menu (use the Options dialog box to choose the commands you would like to display).

Use the same mouse button on the tab bar and you will get a choice of commands for managing the open
documents.

Most of the editor's other components also have dedicated shortcut menus.

Look at the hint line for more information about a highlighted menu item.



Keyboard Shortcuts
Many of the editor's commands are available through keyboard shortcuts (most shortcuts that are 
standard to Windows are not listed here - see the Windows help file for those). The shortcut keys and 
their meaning are detailed below:

Editing Text

Ctrl+Z Undo changes
Ctrl+Shift+Z Redo (NoteTab Pro)
Ctrl+A Select all text
Ctrl+X Cut selection to clipboard
Ctrl+C Copy selection to clipboard
Ctrl+V Paste selection from clipboard
Ctrl+Y Delete current line
Ctrl+K Invert case of selected text
Ctrl+U Change selected text to upper case
Ctrl+L Change selected text to lower case
Shift+K Capitalize; make a words first character upper case and the rest lower case
Ctrl+J Append next line to current line, or join selected lines
Ctrl+Shift+J Split into separate lines
Ctrl+I Indent current line or all selected lines
Ctrl+Shift+I Unindent current line or all selected lines
Ctrl+Enter Inserts a page-break character
F2 Expand text; replaces selection or word preceding the caret with corresponding Clipbook

item (the word may be entered partially - the first matching Clipbook item is used)
F5 Insert current date/time

Handling Documents

Ctrl+O Open a document from disk
Ctrl+N Create a new document
Ctrl+S Save changes made to document
Shift+Ctrl+S Opens the Save As file dialog box
Ctrl+F4 Close the current document
Ctrl+P Print the current document
Ctrl+Tab Switch to next document
Ctrl+Shift+Tab Switch to previous document
Ctrl+G Shift focus to current document
Ctrl+W Toggle word wrap
Shift+Ctrl+x Insert or toggle a bookmark at the caret position within a document (x is a number 

between 0 and 9)
Ctrl+x Move the caret to the specified bookmark number (x is a number between 0 and 9)

Finding and Replacing Text

Ctrl+F Open find dialog box
Ctrl+R Open Search/Replace dialog box
F3 Search again
Shift+F3 Search again in other direction

Tools

ESC Show or cancel In-Context Clipbook



Ctrl+double-click Opens the clicked link in your browser or jumps to hyperlink
Ctrl+Shift+C Copy selection to Clipbook (must be open!)
Shift+F2 Open "Favorite Files" dialog box
F4 Show or activate the Clipbook window
F6 Show or activate the File List
F7 Open file based on name under the caret
F8 Show current HTML document in web browser
F9 Open Internet link
F10 View text statistics
F11 Spell check (not available in Freeware version)
F12 Thesaurus (not available in Freeware version)
Alt+1 (2,3,...) displays the first Clipbook library in the combo box list; Alt+2 displays the second, and so

on...

Other

Shift+F10 Opens shortcut menu



Command-line Parameters
You can specify as many parameters as the command line can take. Each parameter must be separated 
by a space.

/NS Don't show splash screen (must be first parameter). There is also an option in the 
Options dialog box.

FileName Opens specified file in the editor.    File name can also include wildcards. If you 
want to specify several file names, enclose each name between double quotes, 
eg.
NoteTab.exe "c:\autoexec.bat" "c:\config.sys"

/F=FavoritesFileName Specify an alternative Favorites list file name (without extension or path). The file 
name must follow the equal sign. Do not use any spaces before or after the equal.
Favorites lists must be in the same folder as the editor. If the file does not exist, it 
will be created. If you want the files in the list to open automatically on startup, 
make sure you check the Auto Load Favorites option in the Options dialog box.

/P  Print the files listed in the command-line parameter.

/R Open the files following this parameter as Read-Only.

/B Browse mode: the editor will not allow editing of documents.

/J=xxx Jumps to specified line number (xxx) when the editor is opened. This argument 
can be specified after every file name. If J=-1, the caret will be placed at the 
beginning of the last line.

/INI=FileName Specify an alternative INI file. If you don't indicate a path, the program's directory 
is assumed. If you indicate a path name, there should not be any spaces in it (if 
this is the case, use the short DOS name instead). You do not need to specify an 
extension (it is always INI).



Date and Time filters
The editor has a command that lets you easily insert the current date and time in your documents. You 
can do so with the Insert Date command (in the Document menu) or automatically if you are using the log 
feature. By default, it uses the format specified by the ShortDateFormat defined by Windows. You can, 
however, customize the date by creating a Date Filter – the field is available in the Options dialog box on 
the Miscellaneous tab. There is also a similar field in the Print dialog box. Filters can also be used in text 
that is added to the Clipbook (see topic for more information). The following format specifiers are 
supported:

Specifier Displays

c Displays the date using the format given by the ShortDateFormat global variable, followed 
by the time using the format given by the LongTimeFormat global variable. The time is not 
displayed if the fractional part of the DateTime value is zero.

d Displays the day as a number without a leading zero (1-31).
dd Displays the day as a number with a leading zero (01-31).
ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by the 

ShortDayNames global variable.
dddd Displays the day as a full name (Sunday-Saturday) using the strings given by the 

LongDayNames global variable.
ddddd Displays the date using the format given by the ShortDateFormat global variable.
dddddd Displays the date using the format given by the LongDateFormat global variable.

m Displays the month as a number without a leading zero (1-12). If the m specifier 
immediately follows an h or hh specifier, the minute rather than the month is displayed.

mm Displays the month as a number with a leading zero (01-12). If the mm specifier 
immediately follows an h or hh specifier, the minute rather than the month is displayed.

mmm Displays the month as an abbreviation (Jan-Dec) using the strings given by the 
ShortMonthNames global variable.

mmmm Displays the month as a full name (January-December) using the strings given by the 
LongMonthNames global variable.

yy Displays the year as a two-digit number (00-99).

yyyy Displays the year as a four-digit number (0000-9999).
h Displays the hour without a leading zero (0-23).
hh Displays the hour with a leading zero (00-23).
n Displays the minute without a leading zero (0-59).
nn Displays the minute with a leading zero (00-59).
s Displays the second without a leading zero (0-59).
ss Displays the second with a leading zero (00-59).
t Displays the time using the format given by the ShortTimeFormat global variable.
tt Displays the time using the format given by the LongTimeFormat global variable.
am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any hour 

before noon, and 'pm' for any hour after noon. The am/pm specifier can use lower, upper, or
mixed case, and the result is displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour 
before noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or 
mixed case, and the result is displayed accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays the contents of the 
TimeAMString global variable for any hour before noon, and the contents of the 
TimePMString global variable for any hour after noon.

/ Displays the date separator character given by the DateSeparator global variable.



: Displays the time separator character given by the TimeSeparator global variable.
'xx' Characters enclosed in single quotes are displayed as-is, and do not affect formatting.

Format specifiers may be written in upper case as well as in lower case letters--both produce the same 
result.
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Updates
You will find information on updates at the following address:

http://www.unige.ch/sciences/terre/geologie/fookes/

And if all goes well, NoteTab will soon have its own Internet domain address at:

http://www.notetab.com/

You can purchase the commercial versions of NoteTab by visiting the ideaMarket web site at the following
address...

http://www.ideamarket.com/

NoteTab customers are automatically notified when updates become available.



Contacting the Author
I receive many E-mails from NoteTab users all over the world, and really appreciate the comments and 
suggestions sent to me. Without them, I would probably have stopped working on the software long ago. 
Also, much of the feedback I get influences the evolution of NoteTab. However, because of the    volume 
of messages involved, I am sorry to say that I cannot respond to them all (if I did, I could no longer 
develop NoteTab). So please forgive me in advance if I don't respond to your inquiry; it does not mean 
that I have ignored your feedback (I never do).

If you are submitting a bug report, please first check the list of known problems in the last part of the 
README.TXT file. Also check, if possible, whether the bug has been fixed in the latest update. 
Remember to indicate which program variant and version number you are using.

I can be reached by E-mail at:

fookes@sc2a.unige.ch

        (or    Eric.Fookes@terre.unige.ch)

or by snail mail at the following address:

Eric G.V. Fookes
Av. Eugène-Pittard 22 Ter
CH - 1206 Geneva
Switzerland



License (Commercial version)
IMPORTANT - THIS IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN 
ENTITY) AND ERIC G.V. FOOKES. BY USING THE NOTETAB SOFTWARE, YOU ACKNOWLEDGE 
THAT YOU HAVE READ THIS LICENSE AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND 
BY ITS TERMS. YOU FURTHER AGREE THAT IT IS THE FULL AND COMPLETE AGREEMENT 
BETWEEN US, SUPERSEDING ALL PRIOR WRITTEN OR VERBAL AGREEMENTS OF ANY KIND. IF 
YOU DO NOT UNDERSTAND OR DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU 
MUST CEASE USING THIS PRODUCT IMMEDIATELY AND PROMPTLY DESTROY ALL COPIES OF 
THE SOFTWARE AND DOCUMENTATION.

The program and related files are proprietary products of Eric G.V. Fookes ("LICENSER"). Super NoteTab
and NoteTab Pro, including related files distributed with the package, are hereinafter collectively referred 
to as the "SOFTWARE".

1. GRANT OF LICENSE. This License Agreement permits you to use one copy of the SOFTWARE on a 
single computer. The SOFTWARE is in "use" on a computer when it is loaded into temporary memory (i.e.
RAM) or installed into permanent memory (e.g. hard disk, CD-ROM, or other storage device) of that 
computer. However, installation on a network server for the sole purpose of internal distribution shall not 
constitute "use" for which a separate license is required, provided you have a separate license for each 
computer to which the SOFTWARE is distributed.

2. COPYRIGHT. The SOFTWARE is owned by the LICENSER or its suppliers and is protected by the 
copyright laws and treaties. Therefore, you must treat the SOFTWARE like any other copyrighted material
(e.g. a book or musical recording) except that you may either (a) make one copy of the SOFTWARE 
solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you 
keep the original solely for backup or archival purposes.

3. OTHER RESTRICTIONS. Any redistribution, transfer, lending, sharing, or use by parties other than the 
licensee is a violation of copyright laws. You may not reverse engineer, decompile, or disassemble the 
SOFTWARE.

LIMITED WARRANTY. This program is provided "as is" without any warranty of any kind, either 
expressed or implied, including, but not limited to, the implied warranties of merchantability and fitness for
a particular purpose. The entire risk as to the quality and performance of the SOFTWARE is wi th you, the
licensee. Should the SOFTWARE prove defective, you assume the risk and liability for the entire cost of 
all necessary repair, service, or correction. Some states/jurisdictions do not allow the exclusion of implied 
warranties, so the above exclusion may not apply to you. This warranty
 gives you specific legal rights, and you may have other rights which vary from state/jurisdiction to 
state/jurisdiction. 

The LICENSER does not warranty the functions contained in the SOFTWARE will meet your 
requirements, or that the operation of the SOFTWARE will be error-free or uninterrupted. Good data 
processing procedure dictates that any program be thoroughly tested with non-critical data before relying 
on it . The user must assume the entire risk of using the SOFTWARE. ANY LIABILITY OF THE SELLER 
WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE 
PRICE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by applicable law, 
in no event shall the LICENSER or its suppliers be liable for any damages whatsoever (including, without 
limitation, damages for loss of business profits, business interruption, loss of business information, or any 
other pecuniary loss) arising out of the use or inability to use this SOFTWARE, even if the LICENSER has
been advised of the possibility of such damages or for any claim by any other party. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for cons equential or incidental 



damages, the above limitation may not apply to you.

If you are not the registered owner of this SOFTWARE, please visit http://www.ideamarket.com to 
purchase your own fully-licensed copy.



License (Freeware version)
IMPORTANT - THIS IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN 
ENTITY) AND ERIC G.V. FOOKES. BY USING THE NOTETAB SOFTWARE, YOU ACKNOWLEDGE 
THAT YOU HAVE READ THIS LICENSE AGREEMENT, UNDERSTAND IT, AND AGREE TO BE BOUND 
BY ITS TERMS. YOU FURTHER AGREE THAT IT IS THE FULL AND COMPLETE AGREEMENT 
BETWEEN US, SUPERSEDING ALL PRIOR WRITTEN OR VERBAL AGREEMENTS OF ANY KIND. IF 
YOU DO NOT UNDERSTAND OR DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, YOU 
MUST CEASE USING THIS PRODUCT IMMEDIATELY AND PROMPTLY DESTROY ALL COPIES OF 
THE SOFTWARE AND DOCUMENTATION.

The program and related files are proprietary products of Eric G.V. Fookes ("LICENSER"). Super 
NoteTab, including related files distributed with the package, are hereinafter collectively referred to as the 
"SOFTWARE".

1. GRANT OF LICENSE. This License Agreement permits you to use the Freeware version of the 
SOFTWARE on any computer.

2. COPYRIGHT. The SOFTWARE is owned by the LICENSER and is protected by the copyright laws and
treaties.

3. DISTRIBUTION. The SOFTWARE package - including all related program and documentation files 
CANNOT be modified in any way and must be distributed as a complete package. You may charge a 
distribution fee for the package, but you must not represent in any way that you are selling the software 
itself.

4. OTHER RESTRICTIONS. You may not reverse engineer, decompile, or disassemble the SOFTWARE. 
Any such unauthorized use shall result in immediate and automatic termination of this license.

LIMITED WARRANTY. This program is provided "as is" without any warranty of any kind, either 
expressed or implied, including, but not limited to, the implied warranties of merchantability and fitness for
a particular purpose. The entire risk as to the quality and performance of the SOFTWARE is wi th you, the
licensee. Should the SOFTWARE prove defective, you assume the risk and liability for the entire cost of 
all necessary repair, service, or correction. Some states/jurisdictions do not allow the exclusion of implied 
warranties, so the above exclusion may not apply to you. This warranty gives you specific legal rights, 
and you may have other rights which vary from state/jurisdiction to state/jurisdiction. 

The LICENSER does not warranty the functions contained in the SOFTWARE will meet your 
requirements, or that the operation of the SOFTWARE will be error-free or uninterrupted. Good data 
processing procedure dictates that any program be thoroughly tested with non-critical data before relying 
on it . The user must assume the entire risk of using the SOFTWARE.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by applicable law, 
in no event shall the LICENSER or its suppliers be liable for any damages whatsoever (including, without 
limitation, damages for loss of business profits, business interruption, loss of business information, or any 
other pecuniary loss) arising out of the use or inability to use this SOFTWARE, even if the LICENSER has
been advised of the possibility of such damages or for any claim by any other party. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for cons equential or incidental 
damages, the above limitation may not apply to you.

All rights not expressly granted here are reserved by Eric G.V. Fookes.



History of NoteTab
NoteTab has been a leader in innovations brought to the field of text editors ever since the first version. 
Many of these original features have now been copied by competing software. Here is a short outline of 
the most significant features first introduced by NoteTab:

October 1995:
Introduction of the first version of NoteTab (called Mini NoteTab) for Windows 3.x. It was one of the first 
text editors (perhaps even the first) to use a tabbed layout instead of the cumbersome MDI interface.

December 1996:
Favorites dialog box was introduced. This feature made it very easy to find files and directories no matter 
where they are located on the hard disk(s).

January 1997:
The powerful and very popular "Editor Clipbook" tool was created and integrated in NoteTab version 2.0. 
Although this feature is being increasingly copied, the original Clipbook remains the uncontested leader in
ease of use, power and flexibility.

Web-enabled features: lets you easily open links in your default browser by clicking on them with the 
mouse. Added a command to preview HTML documents in web browser.

June 1997:
The convenient In-Context Clipbook was introduced in NoteTab version 3.0.

February 1998:
NoteTab version 4.0 introduces many original features never seen in text editors before. These include:
· Outline documents with hypertext links
· Clipbook Wizards
· Customizable shortcut menu
· Calculates mathematical expressions
· Easiest method ever to replace MS Notepad with alternative editor
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